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Falmouth History Archive Database Part 3 

Annotations 

Annotations are comments that you can add to a record for any reason you choose.  They do not 

form part of the Archive data but sit alongside it.  Think of them as ‘Post-it’ notes; they are also 

yellow.  They allow users to make personal6 notes within the database as an aid to research, for 

sharing a comment between users, or for any other reason where a note sitting outside the data 

record is required.  You can add annotations just for yourself, for all users or for a specified group or 

groups of users.  Administrators can always see all annotations but otherwise you control who can 

view them.  You must have either Editor or Administrator permission to add annotations. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
6 Administrators can always see all annotations 

To add an annotation, 
right click the record detail 
and click on Add 
annotation then choose 
the scope for your 
annotation from the 
submenu: 
for everyone, for me 
only or for specified 
group. 
In this example choose 
for everyone… 

…this opens the add 
annotation dialog. 
This has 2 tabs: the 
Annotation tab and the 
Permissions tab. 
On the annotation tab there are 
2 fields: Caption and 
Annotation. 
ArchiveDb adds a default 
caption that you can edit as 
required.  The caption can be a 
maximum of 100 characters.  
The Annotation field is blank 
for you to enter your note.  The 
annotation has an unlimited 
length. 
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Once you have typed the 
annotation text… 

…click OK 

The annotation appears at 
the bottom of the record 
detail.  Annotations have a 
yellow background.  The 
record detail also has a 
yellow border applied.  This 
is to indicate that this record 
has an annotation: because 
the annotation is at the 
bottom of the record detail it 
may be offscreen, the yellow 
border is an indication that 
you may wish to scroll down 
to see the comment. 
 
This icon indicates that this 
of annotation is available for 
everyone to see: 

 

Once you have clicked 
OK on the annotation, you 
need to save the record in 
order to save the 
annotation.  Click Save. 
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Adding annotations for groups of users 

 

 

 

 

 

 

 

 

 

 

 

Right click the record 
detail, choose Add 
annotation then for 
specified group from the 
context menu… 

Annotation text can be 
edited directly in the 
record detail pane, but the 
Caption cannot.  
Remember to Save after 
any changes. 
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The permission groups are shared with the File permission groups.  There are 3 system groups: 

Administrators, Editors, and All Users.  All users belong to the All Users group, users having edit 

permission belong to the Editors group and users having administrator privilege belong to the 

Administrators group.  Users are automatically added to their relevant group. 

Existing group lists pre-existing user-defined groups.  Single user lists all users and creates a specific 

type of group containing only the stated user.  It is not possible to further edit a single user group.  

New group allows you to create a new group from the list of current users. 

See File Permission Groups for more information. 

 

 

 

 

 

 

 

 

 

…the Add Permission 
Group dialog opens.  
There are 4 radio buttons: 
System Group 
Existing Group 
Single User 
New Group 
 
Select the appropriate 
group type according to 
your requirement. 

In this example we will 
create a new user-defined 
group named CCH+JWL. 
Select New Group… 

…give the group a 
name… 

…select the Users.  Hold 
down the control key to 
select multiple users. 

Click OK when done 
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If you chose to add the annotation just for yourself, it will display this icon:  

Annotations added for a single group of users display this icon:  for System groups and  

this icon:  for user-defined groups. 

Annotations with more complex viewing permissions display this icon:  

Edit the caption, if 
required and enter your 
annotation text. 

Click OK when done 

The annotation is added 
at the bottom of the 
record detail.  Click Save 
to save the annotation 
with the record. 
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Editing annotations 

Annotations can be edited to change the Caption, annotation text or scope (which users can see the 

annotation) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To edit, right-click the 
annotation and choose 
Edit annotation from the 
context menu. 

Make any necessary 
changes to Comment or 
Annotation text on the 
Annotation tab… 

…the Permissions tab allows you 
to change the scope of the 
annotation.  This annotation can 
be viewed by all.  To restrict that 
you add a group of users as 
described, above. 
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Deleting annotations 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To delete an annotation, right-
click the annotation and 
choose Delete annotation 
from the context menu… 

…you will see a message like this. 
The message requires you to 
confirm deletion and also informs 
you that you need to Save the 
record after deleting the annotation 
to complete the deletion. 
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Searching annotations 

Annotations can be searched using the detailed searches but not the quick search.  If you have 

administrator rights the search applies to all annotations.  If you do not have administrator rights the 

search applies to only those annotations to which you have access: ‘My Annotations’. 

 

 

 

 

 

 

 

 

 

 

 

To view the detailed searches, 
either choose Detail Search 
from the View menu or click on 
the Search button at the bottom 
left of the file Treeview. 
On the Selected File/Schema 
tab there is a yellow checkbox 
field for each of the annotation 
text and caption.  As stated 
above, the search applies only 
to those annotations to which 
you have access.  The 
annotation text and caption 
fields are both text fields.  See 
Detailed Searches for more 
information on searching text 
fields. 
The annotation text is a long text 
field and cannot be sorted.  
Caption cannot be sorted in the 
Selected File/Schema search. 

Complete the deletion by 
clicking Save or using 
keyboard shortcut Ctrl+S. 
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Export Datagrid 

It is possible to export the contents of the datagrid to an existing Microsoft Access database.  The 

database can be either an *.mdb or *.accdb file.  It is possible to export an entire table or the results 

of a detailed search.  It is currently not possible to export the results of the Quick Search. 

Export browsed file records 

 

 

 

 

 

 

 

 

 

 

 

On the Checked Files Search 
annotations appear as a table 
labelled My Annotations.  This 
has 2 fields: Annotation text 
and Caption. 
As in the Selected File/Schema 
search, you are only able to 
search annotations to which you 
have access.  If you are an 
administrator, then that is all 
annotations. 
In the Checked Files Search it 
is possible to sort the annotation 
captions but, again, not possible 
to sort annotation text as this is 
a long text field. 
See Detail Searches for more 
information on searching text 
fields. 

To export all records in 
the File BF11 Penryn, 
select the File for 
browse… 
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…and click Export 
DataGrid from the File 
menu 

Navigate to and select 
the existing Access 
database file that is to 
be the destination… 

…click Open 
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You can add additional fields from the primary record.  These are: 

SYSTEMDATETIME (date/time the record was created) 

ID (Primary Key of record) 

FK_FILES (Foreign Key to the parent File, i.e. File ID) 

ID_PARENT (Foreign Key to the parent record.  This will currently be an empty value) 

LASTMODIFIED (date/time the record was last modified) 

FINC (Record Serial Number: Serial number of record within File) 

UID (Universally Unique Identifier for record) 

D_PRIM_TITLE (Record title, if any) 

Of these, the most useful are likely to be ID and FK_FILES as these allow you to create useful joins to 

other exported tables.  Creating joins in exported tables is an advanced topic that is not further 

discussed, here. 

 

Click Start Export 

Select any additional 
fields from the Primary 
Record that you wish to 
include in the export 
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Output table in Browse File export  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ArchiveDb field names in the 
output are preceded by F_ as 
this prevents field names 
conflicting with Access reserved 
words. 
The ArchiveDb field name 
shown is the underlying 
fieldname without spaces.  It 
may differ slightly from the 
Caption displayed on screen 
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Export Selected File search 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is a query to 
generate a subset of the 
selected file where the 
Serial value is <10… 

…click Export DataGrid to export the 
results of the query.  The remaining steps 
are the same as those outlined, above. 
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Export Files Sharing Schema search 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is a query to 
generate a subset of the 
selected files where the 
Serial value is <10… 

…click Export DataGrid to export the 
results of the query. 

After selecting the access 
database the Export dialog 
will be presented with a 
default name for the table to 
be created.  You may wish to 
change this to something 
more meaningful. 

FK_FILES (File ID) should be 
included in the additional 
fields as the search may 
return records from more than 
one file and you may need to 
differentiate those files in the 
output. 
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Export checked files search 

The exported table matches the field selection you make.  FK_FILES is always include in the output as 

the result of the checked files search may include records from many files.  FK_FILES cannot 

currently be selected as a query field.  Record Serial Number is equivalent to FINC in the Export 

dialog. 

 

 

 

 

 

 

 

 

 

 

Select the Access database as outlined in previous steps. 

 

 

 

 

 

 

 

 

 

 

 

 

Set up and run the 
search then click 
Export DataGrid 
from the File menu 

The Export dialog will be 
presented with a default name 
for the table to be created.  
You may wish to change this 
to something more 
meaningful. 

The primary record field 
selection cannot be edited: it 
is determined by the field 
selection you made when 
setting up the query.  
FK_FILES (File ID) is always 
included both here and in the 
query result. 
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Output table in Checked Files Search 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ArchiveDb field names in the 
output are preceded by F_ as 
this prevents field names 
conflicting with Access 
reserved words. 
 

If the ArchiveDb query field is a 
DSUB table (ie un-named field), 
there are 2 columns generated per 
ArchiveDb field: the first is the field 
name and that is listed in the 
FNAME_DSUB_xyz column.  In this 
example the field name in 
ArchiveDb is LOCATION.  If you 
have selected a table that does not 
have data in all the checked files, 
No Relevant Data will be shown, as 
required. 

Location data 
(DSUB_GEO) 
is output in 2 
columns, LAT 
and LON. 
Decimal table 
data 
(DSUB_DEC) 
also outputs 
the prefix and 
value in 
separate 
columns 

This column’s 
source is a 
field common 
to the checked 
files in the 
search and the 
column name 
begins F_ 
followed by the 
ArchiveDb field 
name 
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Administrator Privileges  

Files Context Menu: Additional Commands 

 

 

 

 

 

 

 

 

 

 

 

 

Re-index File 

The re-index File command rebuilds the word and date indices for the specified file.  These indices 

were discussed earlier under the heading Record indexing and searching.  It should rarely be 

necessary to rebuild the index of an individual File, it is much more likely that you will need to 

rebuild the index for the whole database; see Index All, later. 

Delete File 

This command is only available to Administrators as it will permanently delete not only the selected 

File but all records contained within that File.  For that reason, you are safeguarded by having to OK 

a couple of message boxes first. 

 

 

 

The administrator role 
adds 2 new 
commands to the File 
context menu: 
Delete File and... 

...Re-index 
File 
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Folder Context Menu: Additional Commands 

There are 3 additional commands on the series context menu: 

 

 

 

 

 

 

 

 

 

 

 

Edit Folder Definition 

Folders can be Fonds, Sub-Fonds, Series, etc.  The context menu item will state which folder type it 

refers to. 

The folder definition has several fields: Title, Hierarchy Code, Hierarchy Level, Description and Notes.  

The Title field can contain up to 100 characters, Hierarchy Code 10 alphanumeric characters, 

Description and Notes are unlimited.  The most important ISAD(G) fields are included beneath 

Notes. 

 

 

 

 

 

 

 

 

Hierarchy Code 

Hierarchy Code forms part of the Hierarchy Reference Number and is mandatory.  It must be unique 

within its folder.  You may choose to use numbers or a more meaningful alphanumeric convention. 

…Edit Series 
Definition... 

...Add New 
Folder... 

...Delete Series Folder 
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Corresponds to ISAD(G) Reference Code. 

Hierarchy Level 

Corresponds to ISAD(G) Level of Description 

 

 

 

 

 

 

 

The full list of Hierarchy Levels is: 

Institution 

Fonds 

Sub-Fonds 

Series 

Sub-Series 

File 

Item 

ArchiveDb allows unlimited Sub-Sub(etc)-Fonds and Sub-Sub(etc)-Series. 

Add New Folder 

 

 

 

 

 

 

In this example we create 
a Sub-Series of Boxfiles. 
Right click Boxfiles and 
choose Add New Folder 

Hierarchy Level is selected from 
the list.  The available options are 
filtered by the parent folder 
hierarchy level.  In this example the 
parent folder is a Fonds and 
children of Fonds may be Sub-
Fonds or Series.  The 
Unspecified option is always 
available and Unspecified folders 
have yellow folder icons 
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Complete fields as required: it is 
mandatory to give the folder a 
title and Hierarchy Code.  A 
default numeric code has been 
assigned.  You can give this a 
meaningful alphanumeric value. 

The parent folder was a Series 
and the only options for a child of 
a Series are Sub-Series or 
Unspecified. 

When all required fields have 
been completed, click OK. 
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Delete Series Folder 

In order to delete a series folder you must first empty it of Files.  This can be done by moving all the 

Files to another series, see below. 

Dragging and dropping Files and Folders 

 

 

 

 

 

 

 

 

 

 

 

My New Sub-Series, is 
placed hierarchically and 
alphabetically  

To move the My New 
Sub-Series folder to the 
ΩTest Series, select My 
New Sub-Series with the 
left mouse button, then 
drag to the ΩTest 
Series... 
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Individual Files can be moved between folders by dragging and dropping in a similar manner. 

Duplicate Codes on Dropping 

Hierarchy Codes are constrained to be unique within their folder.  This means that, if you drag a 

folder from another folder, its existing code may duplicate a code that already exists in its 

destination.  In that case you will see this message.  This tells you that the code of the folder you are 

moving will be changed to the value shown in the message.  You can OK the message and then 

follow up by editting to change the code in the dropped folder to a suitable value. 

 

 

 

 

 

...accept the message... 

...and the folder will be 
reallocated along with any 
contained files 
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File menu: Additional Commands for Administrators 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The View Error Log 
command is exclusive to 
the admin login... 

It opens this form… 

...you will need to 
maximise the form... 

...and resize the columns to 
make it readable. 
 
This is a list of all the program 
errors that have been trapped 
and recorded.   
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Edit menu: Additional Commands for Administrators 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Index All 

Complete re-indexation will be required if the list of common words excluded from the word index is 

changed at any time.  It is also possible that the word counts associated with the index could 

become inaccurate if more than one user saves a record simultaneously and both records contain a 

matching word that is saved to the index at the same moment.  This behaviour has not been 

validated but, as it is theoretically possible, assume it may happen at some point.  The word counts 

are used to optimise the search SQL statements.  If they become significantly incorrect then the 

performance of the search could be degraded.  The results of the search will, however, not be 

affected. 

The Index All command 
rebuilds the word and date 
indices for the whole database.  
Expect this to take several 
hours. 

Setup allows the Archive 
Name to be edited and 
sets the default image 
and document save 
locations. 

Connection String sets 
the Firebird server 
database connection 
information  

Paths sets the directories 
to which images and 
documents will be saved 

Schemas currently 
displays a read-only list of 
Schemas with their 
associated files.   

Google API Key sets the Google API 
Key necessary to use some of the 
Geo-location features such as the 
address search 

Permission Group 
Maintenance provides a 
couple of further 
commands on a sub 
menu, see below.   

User Maintenance opens 
a dialog to add, edit and 
inactivate users.  Includes 
password reset. 

AV Transcription Tool Opens free 
standing AV Transcription Tool.  See 
Appendix 2 
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Setup 

The Setup command opens the Setup Form.  You can change the data in the Value column of the 

grid.  These settings are system wide. 

 

 

 

 

 

 

 

 

 

 

 

 

 

STOREIMAGEINDB and STOREBINARYINDB  

These settings are system wide. 

 

 

 

 

 

 

See Adding images to data records => Storage options (earlier) for a description of the Storage 

Options. 

 

ARCHIVENAME sets the application title and the 
name of the root node in the Navigation Tree View 

SHORTNAME is your chosen abbreviation for the 
archive name.  This field is not currently used 
within ArchiveDb 

STOREIMAGEINDB sets the default storage 
option for images.  You should not change from the 
Recommended option. 

STOREBINARYINDB sets the default storage 
option for documents.  You should not change from 
the Recommended option. 

Select one of the setting values from the 
combo-box.  The recommended setting is 
Copy to Server 

SHOWHIERARCHICALREFERENCES determines if 
the Hierarchy Reference Codes are displayed in the 
Detail Pane.  Set the Value as True or False.  It’s plain 
text so take care with spelling. 

Value of REFERENCESEPARATOR is forward 
slash.  You can change the character.  Some 
archives may wish a full stop/period. 

SHOWUUID determines if the UUID is displayed in the 
Detail Pane.  Set the Value as True or False.  It’s plain 
text so take care with spelling. 

FOLDERSFIRST determines 
whether sub-folders are loaded 
before Files when the TreeView 
loads children.  Set the Value as 
True or False.  It’s plain text so take 
care with spelling. 
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Connection String 

 

 

 

 

Connection String is a individual workstation setting. 

The connection string will be similar to this: Database=ARCHIVE;DataSource=server;Port=3050;   

The format is Parameter name=Value; 

Note the semi colon at the end of each parameter/value pair.  You can change the Value that follows 

the ‘=’, but not the Parameter name that precedes it. 

Database Parameter 

This is the name of database as specified in the databases.conf file in Firebird setup on the server, or 

is the file name and path to the database file on the server or local workstation.  If Firebird is running 

on a server then the path is the path as seen by the Firebird server i.e. it will be a local path, not a 

network path.  It is not the path from the workstation to the database file.  

DataSource Parameter 

This is the location of the Firebird server.  This may be the name of the physical server on which 

Firebird is running, or its IP address.  If the Firebird server is located on the same workstation as 

ArchiveDb then the DataSource is LOCALHOST.  At The Poly the server is called server. 

Port 

This is the port that the Firebird server listens to, and it is set when the Firebird server is installed.  It 

is 3050 by default.  It will be a value other than 3050 if 3050 is being used by another program or 

service meaning that Firebird had to be allocated another port on installation.  3050 is typically 

assigned to Firebird. 

The Connection String 
command opens this form that 
allows you to edit certain 
database connection parameters 
if the database server is moved 
or changed, or at initial setup. 
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Paths 

The Paths command opens the Path Setup form. 

 

 

 

 

 

 

 

Path Setup specifies the file locations for saving images and documents to the server or associated 

network storage.  Paths are saved to a PATHS table on the Firebird server that has a data relation to 

the table containing the binary data for images and documents.  Each image file or document file 

record contains the ID of the Path record from the PATHS table rather than the actual text value of 

its path.  This avoids having to save a long path string with each file record. 

There are 3 paths to specify: one for images, one for the thumbnail associated with each image and 

one for documents.   

In a new ArchiveDb system you will need to add these 3 paths7.  Click Add Path to open the Add Path 

dialog. 

 

 

 

 

 

 

Once the Path has been added, it can be selected in the Path Setup form. 

The selected path values determine the directory to which ArchiveDb will save newly added images 

and documents.  If you add a further path and then select it, then future files will be saved to that 

destination but the existing files will be unaffected.  You will then have split your file storage.  This 

may be desirable if you have a very large number of files to store.  For example, if you have several 

hundred thousand image files, having these in a single directory will make it difficult/slow to view 

 
7 In the event that you have an installation with only a few documents and images, you could add a single path 
to use for all files, both images and documents. You would then select the same path for images, thumbnails 
and documents.   

Name of Path 

Select the relevant Path 
from the combo-box drop 
down 

Add a new Path to the list 
of available paths 

Edit the value of an existing Path 

Select the required network 
directory. 
Click OK when done. 
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the directory contents in File Explorer, should the need arise.  You might then decide to limit the 

number of files to, say, 50,000 per directory.  You could do this by adding and selecting a new path 

when the existing directory contained its quota.  Future images would then be added to the ‘new’ 

directory specified by the new path.  There is no automatic way to do this – it is a manual process.  

From personal experience of around 220,000 image files in a single directory, database performance 

is unaffected but opening the directory in File Explorer is extremely slow. 

Moving existing files 

We have so far discussed how to specify the directory to which newly added files will be saved.  

However if existing files need to be moved, the value of the relevant existing Path needs to be Edited 

by clicking the Edit button next to the appropriate path.   

Imagine that we have all the image files on the POLYSERVER and we move these to a network 

attached storage drive, NASDRIVE.  Were we to copy all the image files across to NASDRIVE and then 

add the NASDRIVE path, as shown below, this would create a new path with an ID of 2 (see Table of 

Paths, below).  Any new images added would be saved to the correct location (Path ID 2) but the 

existing image records (see Table of Files) that all have a Path_ID of 1 (referring to POLYSERVER) 

would no longer be found by ArchiveDb. 

Table of Paths 

ID Path 

1 \\POLYSERVER\FHA\FILES\IMAGES 

2 \\NASDRIVE\FHA\FILES\IMAGES 

 

Table of Files 

Path_ID FileName 

1 Image1.tif 

1 Image2.tif 

 

The correct solution is therefore to Edit the existing Path value ‘\\POLYSERVER\FHA\FILES\IMAGES’ 

and change it to ‘\\NASDRIVE\FHA\FILES\IMAGES’.  This results in the record with ID 1 in the Table 

of Paths having the new file location. 

Table of Paths 

ID Path 

1 \\NASDRIVE\FHA\FILES\IMAGES 
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Schemas 

TreeView of all Schemas showing schema fields and files allocated to the schema. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

List of Schemas. 

Expand the Schema 
nodes to view the fields… 

…and allocated Files 

The Schema node has a 
context menu… 

…you can Edit the 
Schema… 

…and create a new 
Schema 

These commands expand 
and collapse the 
TreeView nodes. 
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Permission Group Maintenance 

 

 

 

 

 

 

 

 

 

 

User-Defined Permission Groups 

 

 

 

 

 

 

 

 

 

 

 

 

Permission Group Maintenance 
has 2 sub-menus: 

• User-Defined 
Permission Groups 

• Files with set 
permission 

The User-Defined Permission 
Groups command opens this 
dialog that allows Permission 
Groups to be edited. 
Take care editing group 
members when a group is 
allocated to more than 1 File. 
 

Selecting a group enables the 
editing buttons to the right and 
displays the group members in 
the right-hand grid… 
 

…it also displays the number of 
File allocations for the group. 
 
Always be minded of 
unintended consequences of 
making changes to groups with 
several File allocations. 



207 
 

 

 

 

 

 

 

 

 

 

 

 

Deleting groups 

 

 

 

 

 

 

 

 

 

 

Respectively, these buttons 
allow creation of a new group, 
renaming the selected group, 
deleting the selected group and 
display a list of Files to which 
the group is allocated. 

Group members are displayed in this 
grid and users can be added or 
removed using the buttons to its right. 
Remember, if you change group 
members, you may create permission 
conflicts in the Files to which the 
group has been allocated. 

If deleting a group that has 
been allocated to one or more 
Files, you will be prompted with 
this dialog... 

...you can click OK to delete 
anyway, Cancel to abandon the 
delete, or select a file in the list 
and view the File Setup.   

The selected group is allocated 
to 2 Files.  Click Show Files to 
view a list of Files allocated the 
selected group… 

…double click a File or select 
and click File Setup… to open 
File Setup for the File. 
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Files with set permission 

Files with set permission is a helper utility to assist managing Permission Groups and conflicts.  It 

may be useful to open Files with set permission before opening the Group Edit dialog, above, as it 

provides an overview of File Permission Groups, their members, permissions, and any conflicts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Files with set permission 
command opens this form. 
It shows all Files that have one 
or more permission group 
allocated and thus do not have 
universal access. 

Files with permission conflicts 
have a red exclamation. 
Expand the File by clicking the 
glyph to… 

…display the allocated 
Permission Groups for the File 

Right-click a File to display the 
context menu.  This allows you 
to expand or collapse the tree, 
browse the File or go to File 
setup. 
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User Defined groups 
have a blue icon. 
The red triangle indicates 
the group has a critical 
conflict. 

System groups have a 
red icon. 
The yellow triangle 
indicates the group has a 
none-critical conflict. 

Single User groups have 
an orange icon. 
 

The status bar provides 
information about the 
selected item. 

Icons at the right-hand of the 
Permission Group indicate a 
Permission Override: 

Admin:  

Editor:   

Read-Only:  

Expanding the Permission 
Group displays the members. 
Administrators are red, editors 
are dark blue and read-only 
users are pale blue. 

This user is shown in two colours.  
The upper represents the user base 
permission and the lower, the override 
permission of the group, in this case 
Admin, but not necessarily for the File, 
which, in this case would be Edit 
owing to the conflict. 
This user has a red triangle indicating 
a conflict. 
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Click on the conflicted 
user... 

...and the other conflicts 
will highlight in pink. 

The status bar provides information about 
the user and the conflict. 
The icon to the left indicates the 
permission granted to the user for the 
File which, in this case is Edit owing to 
the 2 conlicts. 

To see other File allocations for a 
Permission Group, right-click the 
group and choose Highlight all 
incidences of this Permission 
Group. 

The other allocations will highlight in 
light blue. 
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Change Access Level command 

Change Access Level opens the permission override dialog to change the group override for the File.  

 

 

Rename Permission Group 

Opens the Rename Group dialog.  You will be prompted if the change would also affect Files other 

than the current.  

 

 

Other commands on the Permission Group context menu are as 
follows: 

• Expand/collapse All Permission Groups 

• Change Access Level 

• Rename Permission Group 

• Edit Users 

Expanding all permission groups displays all users for all groups 
and files 
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Edit Users 

Opens the Group Edit dialog with the current members.  You will be prompted if the change would 

also affect Files other than the current.  You can select a User and click Remove User or Add User 

and select a new User to add to the group. 

 

 

 

 

 

 

Editing Groups with multiple File allocations 

 

 

 

 

You will be prompted with a similar dialog to above if you edit group members or rename a group 

that is allocated to more than 1 File.  This is to remind you that you may be about to make a change 

to one or more files other than the one you are working with.  It may be exactly what you want to 

do, or it may inadvertently, for example, undesirably change the user permissions for another File.  If 

you are not sure, check the other allocated Files.  If you are working with the Files with set 

permissions form, you can use the Permission Group context menu to Highlight all incidences of 

this Permission Group command, see page 210, or, if you are working with the Group Edit dialog, 

click the Show Files button, see page 207. 

If you are working with a Permission Group and need to change the users for the needs of a 

particular File but find the group is allocated to another File for which the change is unwanted, the 

simplest answer is to create another group with the updated members and then remove the old 

group from the current File, leaving the group attached to the other File unchanged. 
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User maintenance 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The User Maintenance 
command 

User maintenance shows all users, 
whether they are active or inactive.  
Users cannot be deleted, only 
inactivated.  Selecting a user enables 
the buttons: Inactivate User, Reset 
Password and Edit User 

To inactivate the selected 
user, click Inactivate 
User... 

...the user is immediately 
inactivated 
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Add new user 

 

 

 

 

 

 

 

 

 

 

 

 

 

The user’s Active status is 
now shown as False 

To reactivate the user, 
select the user and click 
Activate User... 

On the user 
maintenance form click 
the Add User button 

Complete all the fields on 
the form: only User Name 
is mandatory 

The default access level 
is read-only, other levels 
are Edit or 
Admin[istrator] 
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Resetting passwords 

The reset password command on the File menu allows an individual user to change their own 

password.  They must be able to type in their existing password to do this.  In the event that the user 

has forgotten their password, this can be reset by an administrator.  That password can then be 

further changed by the user. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the user and then 
click Reset Password 

You will first be prompted 
to enter your own 
administrator password. 

And finally get confirmation 
of the change. 

Acknowledge the prompt 
explaining that the 
password will be reset to 
‘password’.   
The user concerned should 
then edit their password to 
one of their choosing 
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Google API Key 

This functionality is currently disabled. 

The API key enables the address search and some functionality pertaining to Google locations used 

in association with Geo-Location in ArchiveDb.  The key may need to be updated for continued use.  

Search Google for ‘Google API Key.’ 

 

 

  

Enter new Key and click OK 
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Appendices 

Appendix 1 

Oral Histories in ArchiveDb 

ArchiveDb can store the audio (or video) of an oral history along with its transcript.  

Transcripts are indexed and searchable via the Quick Search in ArchiveDb.  Search matches are 

highlighted within the transcript and, assuming the transcript contains timestamps, linked to the 

audio.  When the search result is clicked the audio will automatically play for a short time from just 

before the search match. 

Timestamped transcripts can be edited using the standalone Transcript Tool or the Transcript Tool in 

ArchiveDb.  The standalone Transcript Tool is a small program, or App, that can be installed on any 

computer – home PC, laptop etc – to allow editing away from the Chellew room. 

Timestamps 

Timestamps are time information embedded into the transcript text that synchronise text with 

audio. 

ArchiveDb accepts time stamped transcripts for editing in 3 formats: 

1. Amazon JSON format 

2. Plain text with hours (optionally) minutes and seconds.  For example: 
00:00:00 

and in clifftop paths but in the late 

00:00:03 

18th century Cornwall became famous for 

00:00:05 

something else 
3. Plain text with hours minutes seconds and milliseconds with begin and end times.  For 

example: 
1 
00:00:00,498 --> 00:00:02,827 
Here's what I love most 
about food and diet. 
2 
00:00:02,827 --> 00:00:06,383 
We all eat several times a day, 
and we're totally in charge 

Amazon JSON is the format for Amazon audio transcriptions.  JSON files requires a computer 

program to interpret appropriately.  Amazon JSON files can be imported into the ArchiveDb 

Transcript Tool. 

The two plain text formats (above) require the timestamp to look like the blue text and must be on a 

line of their own.  For example the simplest format (hh:nn:ss) requires 2 digits for hours then a 

colon, followed by the minutes and seconds each in 2 digits and separated by a colon and followed 

by a carriage return.  You will not, generally, be typing a timestamp manually; they are usually 

generated by a voice recognition system during computer transcript generation.  They can also be 

generated by the Transcript Tool. 
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Creating transcripts 

Provided that you have a good quality recording, voice recognition is the fastest way to generate a 

transcript, although it will likely need editing and correcting, particularly with respect to place 

names.   

YouTube automatically generates a timestamped transcript for uploaded videos and it is possible to 

upload the video to YouTube and later download the automatically generated transcript.  The 

format is number two, above, plain text with hours minutes and seconds.  This service is free. 

For audio files Amazon Web Services provide a transcription service for a small fee.  One hour of 

audio per month is free, thereafter the cost is around £5 per hour.  This service requires creation of 

an account with access to a debit or credit card and it does not have the most intuitive user 

interface.  The result can be downloaded in Amazon JSON format and then imported into the 

Transcript Tool for editing. 

Google also offer a similar service.  I have not investigated their offering. 

Dragon Dictate can also transcribe audio files on your PC, but the results were inferior to Amazon in 

my test and there is no timestamp information.  Dragon Dictate is quite expensive. 

Audio typing is the brute force method.  Just listen to the audio and type out what you hear.  It is 

possible to generate blank timestamps for an audio file using the Transcript Tool and then type text 

in the appropriate time slot.  Finally, you could just type out the transcript in Word (without 

timestamps) and save as a text file.  This text file can then be uploaded to ArchiveDb.  The text will 

be searchable but there will be no synchrony of search results to the audio file. 

For voice recognition to work well the quality of the audio is important.  There needs to be little 

background noise or echo, and care needs to be given to microphone placement to ensure good 

clarity.  The interviewer should try to avoid over-speaking the interviewee. 

From Recording to Database – the process 

1. Record your interview at the best digital quality: lossless (WAV 44.1k/16bit) if possible 
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2. Edit the audio recording, if necessary 

 

 

 

 

 

 

You may wish to remove parts of a recording – for example redundant preambles – or to bleep out 

certain words.  Various audio editing software is available.  The above screen print is Audacity.  

Audacity is free and able to make the necessary edits.  If the recording generated a lossless audio file 

(WAV) use this as the starting point and export the final edit to MP3.  If the recording is only 

available as MP3 make all the necessary edits at the same time and save the final result just once.  

MP3 is a lossy file format and every time you edit and re-save an MP3 file the sound quality is 

degraded as you compound the losses. 

3. Transcribe the final audio file.  Upload the MP3 file to Amazon Web Services and download 

the transcript JSON file 
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4. Edit the transcription using the ArchiveDb Transcript Tool  

 

 

 

 

 

 

 

 

 

 

See separate instructions for the Transcript Tool in appendix 2.  Save the results to ArchiveDb JSNA 

file. 
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5. Import Audio and JSNA file to ArchiveDb  

You need to be logged in to ArchiveDb as a user with editing privilege  

In ArchiveDb the oral history must be stored in a record of its own and that record must belong to an 

ArchiveDb file8.  It is possible to put any number of oral history records in a file.  This means that you 

could, say, put all oral histories in a single ‘Oral history’ file, put each oral history record in a file of its 

own, or group oral history records into a series of files based on their content. 

The following screen print shows a file called Multimedia that contains 4 records.  The first of these 

is a video 

 

 

 

 

 

 

 

 

 

 

 

 

 
8 Note the ambiguity between database files (ArchiveDb files) and computer files.  

In your 
chosen 
ArchiveDb 
File, click the 
New button 
to create a 
new 
record… 

Any video is 
displayed here.  
The transcript is 
shown beneath. 
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…select Audio 
Visual files… 

In the new 
(blank) record 
click the Add 
File button to 
add the audio 
(mp3) file. 
Note: this is a 
computer file 
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…select the 
audio file… 

…click Open… 

…ensure Storage Option is either 
Copy to Server or Move to Server 
(see ArchiveDb instructions for more 
information) … 

…click OK 

Give the oral 
history record a 
name 
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Right-click anywhere in the 
black multimedia pane to 
display the context menu. 
Click ‘Import Transcript’, 
then ‘From JSNA file’ 

Select the related JSNA 
file you saved with the 
Transcript Tool.  It will 
likely have the same 
name as the audio file... 

…click Open… 
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…click Save 
(note that the transcript 
may not be displayed until 
after saving) 

After saving the transcript 
is displayed 

Drag this slider to move 
through the audio. 
The duration of the audio 
file and the current position 
are displayed below the 
slider 

These buttons respectively 
Play, Fast Forward (more 
relevant to video), Pause 
and Stop the media. 
Pause keeps your position in 
the media, press Play to 
restart from where you 
paused.  Stop stops the 
media and resets the 
position to the beginning. 
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Searching Transcripts 

Using Quick Search 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To search everything in the 
database ensure the root 
node checkbox is checked. 
In this example I have only 
checked the Oral History file 
node meaning that this is the 
only file that will be searched 

Enter search criteria in the 
Quick Search box.  Click 
the search magnifying 
glass button or press Enter 
on the keyboard 

If some files’ checkboxes 
(above) are deselected you 
may see this message to alert 
you that not all files are being 
searched.  To avoid this 
message being shown again, 
check this box.  
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Search results are shown 
here.  The 1st column is the file 
name, the second column 
contains a clickable grid that 
lists each match or partial 
match within the record.  The 
last column contains a 
synopsis of the field data for 
the record. 

The first record returned by the 
search is automatically 
selected and displayed. 

Click a match in the inner 
grid… 

...and the first part of the 
match is highlighted in the 
transcript. 
The audio will play for a few 
seconds before and after the 
match. 
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Searching individual transcripts 

The Quick Search searches the entire database (or your selected ArchiveDb files) for whole words 

that have been indexed.  To search for phrases or partial words within a single transcript you can 

open the transcript in another window and use the transcript window search. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Right-click over the transcript 
to display the context menu, 
click View Transcript in 
another Window 

The Transcript Window 
appears, and you can enter 
search criteria here.  Click 
the Search button to 
highlight matches.  You may 
need to scroll down to view 
the matches as the window 
does not scroll the first match 
into view. 
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Other options 

Searching the database for selected text 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can select to Match Case 
or Match Whole Words 

This window will automatically close 
when you move to another database 
record, but you can choose to keep it 
open when moving to another record by 
clicking this toggle button.  This allows 
you to view two transcripts side by side.  
PDF and image windows have the 
same button and you can opt to keep 
those open as well.  To close these 
windows chose one of the Close 
options from the window context menu 

Select some text in the 
transcript… 

…then right click it to display 
the context menu.  Choose 
Search Database for…  
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Editing transcripts saved in the database 

 

 

 

 

 

 

 

 

 

 

 

…and the database will search 
for your selection.  In this case 
I have checked all the files to 
search everything for Clare 
Terrace  

Right Click the transcript to 
display the context menu.  
Choose Edit Transcript… 
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Additional Transcript Import Choices 

 

 

 

 

 

 

 

 

 

 

 

 

From JSNA file 

This is the option considered above.  It assumes you have saved a transcript in JSNA format using the 

Transcript Tool.  See Transcript Tool instructions. 

From Amazon JSON file 

This option imports the raw, unedited, Amazon JSON file.  The imported file is displayed in the 

Transcript Tool for further editing.  You need to select the timestamp interval (usually 6 seconds) 

when importing. 

…this will open the editing tool.  
Make any changes, click OK 
and then click Save on the 
main database window 

Right Click the Multimedia panel 
to display the context menu.  
Click Import Transcript. 
The 4 options are displayed on 
the secondary menu 
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From Text file 

If you have a transcript saved to a text file, with or without timestamps, you can import it using this 

option.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

From Clipboard 

This option is primarily designed to allow a copied timestamped transcript to be imported directly 

without the need to paste it into notepad, save it as a file and then import from the file.  If you had 

uploaded a video to YouTube for transcribing and then opened the transcript, you need to swipe 

through it to select it.  You can then right click the selection, choose Copy and then use the From 

clipboard option to import it into ArchiveDb.  It will open in the Transcript Tool.  Edit if necessary, 

click OK on the tool then Save on the main database window. 

  

This is what the text file might 
look like.  The timestamps are in 
the format hh:mm:ss, with the 
associated text below the 
timestamp. 

The text file will then be 
imported into the Transcript Tool 
for checking and editing (if 
necessary).  Click OK when 
done and don’t forget to click 
Save on the main database 
window. 
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Appendix 2 

Transcript Tool 

Transcripts for ArchiveDb 

Audio transcripts can be created in several ways: 

1. Manual typing whilst listening to the audio 

2. Transcription by voice recognition.  Amazon provide this service for a small fee.  It works out 

at less than £5 per hour of audio transcription.  The return transcript contains a time 

timestamp for each word.  Amazon returns transcripts in JSON (data interchange) file format  

For video it is possible to upload the video to YouTube and later access the time stamped 

transcript.  This can then be copied and imported into ArchiveDb. 

ArchiveDb accepts time stamped transcripts for editing in 3 formats: 

4. Amazon JSON format 

5. Plain text with hours (optionally) minutes and seconds 
00:00:00 

and in clifftop paths but in the late 

00:00:03 

18th century Cornwall became famous for 

00:00:05 

something else 
6. Plain text with hours minutes seconds and milliseconds with begin and end times 

1 
00:00:00,498 --> 00:00:02,827 
Here's what I love most 
about food and diet. 
2 
00:00:02,827 --> 00:00:06,383 
We all eat several times a day, 
and we're totally in charge 

 

In the absence of a time stamped transcript it is possible to create blank timestamps from an audio 

file and type the text manually into the appropriate timestamp elements. 

Using the Transcript Edit tool 

There are 2 versions of the Transcript edit tool – stand-alone and integrated within ArchiveDb.  The 

stand-alone tool can be accessed from the ArchiveDb Edit Menu command AV Transcription Tool.  It 

is also available as a separate program that can be installed to a Windows computer.  It will then be 

accessed via the Windows Start Menu or a desktop shortcut.  The separate program allows users to 

edit transcripts away from access to ArchiveDb. 

The integrated version is accessed when importing and editing transcripts within ArchiveDb. 
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Open the transcript edit tool from either the Start Menu or Desktop shortcut. 

The transcript tool looks like this: 

 

The next step is to open the media file (audio or video) and the associated transcript file.  ArchiveDb 

and the Transcript Tool save transcript files in JSON file format.  The ArchiveDb transcription file has 

the extension *.JSNA.  It is specific to ArchiveDb and used to differentiate it from the Amazon 

transcript files having the extension *.JSON. 

To begin with you will likely have an Amazon derived transcript with the *.JSON extension. 



235 
 

Editing a new Amazon transcript 

First, open the media: 

 

Click on the File menu then Open then Media, as shown above. 

 

Navigate to the appropriate directory and select the required media file.  Click Open. 
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Next, you need to load the Amazon *.JSON format transcript.  

From the File menu choose Open and then Amazon format JSON 

 

Select the file containing the transcript associated with the media file you have just opened.  In this 

case the file generated by Amazon from the media file is called: asrOutput.json 

 

The raw Amazon file contains timestamp data for each individual word.  This makes editing difficult 

and so the ArchiveDb transcript tool will change the time stamping to a value you select.  You will 

see the timestamp selection dialog: 
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Click on the drop down and select the appropriate timestamp interval.  I would recommend 6 

seconds.  Click OK. 

 

 

The transcript will load and look something like the above screen print. 

Next, save the loaded transcript in ArchiveDb *.JSNA format: 

 

 

 

 

 

 

 

 

 

 

From the File 
menu, click on 
Save 
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You can now edit the transcript.  Save changes regularly by clicking Save as you go. 

When you have finished your edit session, make sure you click Save and then you can choose Exit on 

the File menu or close the application with the cross at the right of the title bar. 

Resuming a saved edit 

You have already saved a transcript in ArchiveDb *.JSNA format (see above). 

Open the Transcription tool.   

 

 

 

 

 

 

 

 

 

 

 

 

The transcript tool will 
assign the same file 
name as the open 
media file but with the 
*.jsna extension.  You 
must save the jsna file 
in the same location as 
the associated media 
file.  

Click Save 

On the File menu, click Open, then  
Media plus Archive format JSON 
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Navigate to the location of your 
files.  You should see a media file 
and a *.jsna file.  Select them 
both; they should have the same 
stem name.  You can select both 
files by clicking on one file and 
then holding the Ctrl key on the 
keyboard whilst you click the 
second 

Click Open 

The media and transcript 
will open and you can 
continue editing 
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Using the editor 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are some important keyboard shortcuts to speed up the editing process by avoiding 

unnecessary use of the mouse. 

These are as follows:  

F1 starts and stops the media 

F2 stops the media and puts the transcript element in edit mode with the cursor at the beginning of 

the text of the current element 

F3 plays just the current element 

ESCAPE undoes the last edit 

TAB commits the last edit and moves to the next element 

Up arrow moves to the previous element 

The current element of 
the transcript is shown in 
yellow.  The current 
element is synchronised 
with the playing audio 

The timestamp is in blue 
and shown in 
hours: minutes: seconds 

The red cross is a Delete 
button.  Click this to delete 
this element of the timed 
transcript 

Click on the speaker icon 
to play the audio 
associated with this 
transcript element 

These buttons respectively 
play, fast forward, pause 
and stop the media. 
Stopping the media 
automatically resets the 
current position back to 
the beginning.  Repeatedly 
pressing the fast forward 
button increases the fast 
forward speed. No audio is 
played during fast forward. 
It is more appropriate to 
video. 

You may drag the 
timeline slider to 
advance the audio. 
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Down arrow moves to the next element 

F5 inserts [SPK1]at the current insertion point – make sure you have clicked inside the element and 

placed the cursor at the correct location. 

F6 inserts [SPK2]at the current insertion point. Use these 2 insertions to identify the interviewer 

and interviewee’s text. They both insert a paragraph as well as the text. For readability leave the 

inserted paragraph in place despite it looking wrong when inserted at the beginning of an element. 

Any text up to a maximum of 18 characters surrounded by square brackets (as in the 2 above 

examples) will be highlighted in the transcript but not indexed in the database, and therefore not 

found by a database search. 

You may also annotate the text with unspoken comments enclosed in curly braces: {}. Annotations 

within curly braces are shown in the transcript and indexed in the database but are intended to 

indicate that the words were not spoken by the interviewee but have been included for clarification. 

For example, if the interviewee was speaking about a castle, you may wish to add {Pendennis} in 

curly braces so that this part of the transcript is returned on a search for Pendennis 

Editing the transcript 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After listening to audio and comparing with the transcript, you will need to correct any obvious 

errors of transcription.  Once you hear something that needs correcting you can press F2 on the 

Begin by clicking the play 
button and listening to the 
audio whilst reading the 
transcript.  The yellow 
highlight will stay in 
synchrony with the audio 

If you wish to delete some 
of the transcript elements, 
say from the beginning of 
the audio, sequentially 
click on the red cross 
delete buttons 
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keyboard to stop the audio and begin editing the current element.  Once you press F2 you will see a 

small border appear around the text and the insertion point (cursor) will be at the beginning of the 

element. You can choose to move the insertion point to the edit point with either the keyboard or 

mouse. 

As an alternative, whilst listening to the audio and watching the transcript, you can simply click on 

the element at the point that requires correction.  The audio will stop, and you will be able to edit 

the element. 

To restart the audio, press F1 or click the play button at the bottom of the window.  If you just want 

to hear the audio associated with the text of the current element, press F3 or click the speaker icon 

to the left of the element. 

Identifying the speaker 

 

 

 

 

 

 

 

 

 

 

 

 

 

These words 
were spoken 
by the 
interviewee 

These words 
were spoken 
by the 
interviewer 

Move the insertion point 
(probably most easily by 
clicking with the mouse but 
you can use the keyboard) 
to the beginning of the text 
spoken by the new speaker 
and then click either F5 for 
the interviewer or F6 for the 
interviewee 
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Find and replace 

 

 

 

 

 

 

 

 

 

 

 

 

 

The F5 command inserts a 
paragraph and the text [SPK1] to 
identify speaker 1, the 
interviewer. 
If you got the insertion point 
incorrect, or pressed F5 when 
you should have pressed F6, you 
can press escape to abandon the 
edit to the current element and 
start again. 

Voice recognition often makes 
errors of transcription.  
Sometimes the same error is 
repeated throughout the text.  In 
this transcription example the 
word and has been mis-

recognised repeatedly and 
transcribed as on DH 

Select the text you want to 
change throughout the document, 
then right click the selection and 
choose Find and Replace from 
the context menu 
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The selected text will 
appear in the Find What 
text box 

Type your replacement text in 
the Replace With text box and 
click on the Replace All button 

The elements that contain 
replacements are then shown 
with the replaced text 
highlighted in red.  You can then 
review the changes and listen to 
the audio associated with the 
element by clicking the speaker 
to the left of the element 

If you are happy with all the replacements, 
you can click OK to write these back to the 
underlying elements.  If you click Cancel 
then no replacements will be made. 

If you are less certain that a certain text 
needs replacing throughout the transcript, 
you can find and replace elements one by 
one.  Set up the Find and Replace with text 
as in the previous example and click Find 
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The Find and Replace dialog does not allow direct text editing.  

The Find What text is shown 
highlighted in red 

To replace the highlighted text in this 
element, click on Replace 
If you want to skip this replacement just 
click Find Next again to move to the next 
occurrence  

The Find button has now changed to 
Find Next button, click Find Next to 
find the next occurrence 

Click on the Replace button to replace 
this occurrence.  Work your way 
sequentially through the elements in 
this way 
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Opening and editing plain text transcripts 

If a video is uploaded to YouTube a transcript is automatically generated.  Download and import this 

as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Open the video in 
YouTube, click the 3 dot 
menu… 

…and click the Open Transcript 
command 

The transcript opens here. 
Drag through the transcript 
with the mouse.  Start 
carefully just before the 
00:00, making sure it is 
selected (it will highlight blue 
when selected)… 
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You now need to copy the selected timed transcript.  The easiest way is to press Ctrl + C on the 

keyboard (hold the Control key down then press the C key).  You can also right click the blue 

selection and choose Copy from the context menu.   

You now have 2 options – either paste the transcript into Notepad, save as a text file and import 

that, OR you can directly import the copied transcript from the Clipboard. 

…drag down until the whole of 
the transcript has been selected.  
Carefully select just to the end of 
the transcript and no more.  
Whilst keeping the mouse button 
pressed you can move the 
mouse back up until the end of 
the last word is selected.  If you 
let go of the mouse button and 
loose the selection you will need 
to start again. 
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Importing from a text file 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On the File menu, choose Open, 
then Plain Text Timestamped 
Transcript (*.txt) 

Select the text file you have saved 
containing the transcript… 

…click Open 
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Importing direct from the clipboard 

This can only be done whilst the transcript is on the Clipboard, i.e. just after you have copied the 

transcript. 

 

 

 

 

 

 

 

 

 

 

 

The imported transcript will 
be displayed.  Remember 
to save as a *.jsna file.  
See above 

From the File menu choose Open 
then Get Plain Text Timestamped 
Transcript from Clipboard 
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Creating blank timestamps 

It is possible to create blank timestamps for a media file.  The transcript can then be typed into the 

appropriate time element.  Begin by loading the media file. 

 

 

 

 

 

 

 

 

 

 

 

The imported transcript will 
be displayed.  Remember 
to save as a *.jsna file.  
See above 

File, Open then Media 
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Select the media file and 
click Open 

From the Edit menu, click 
Create Blank Timestamps 
for current Media 

Select the appropriate time 
interval, say 6 seconds. 
Click OK 
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Other Save options 

The *.JSNA file created when you click Save is the file that you will need to import into ArchiveDb.  

The Save As command on the File menu allows several file types and output styles to be saved.  

These have no relevance to ArchiveDb from an editing or data point of view and are available simply 

to facilitate transcript reading. 

 

 

 

Save As

Transcript with 
Timestamps

Rich Text

Plain Text

Plain Transcript

Rich Text

Plain Text

A series of blank elements 
are created for the media 
file.  Listen to the audio for 
the timeslot and type what 
you hear in the transcript 
cell.  
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From the File menu, choose Save As 
then either Transcript with 
Timestamps or Plain Transcript 

From the drop-down, select either 
Rich Text or Plain Text 
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Below is a plain transcript saved as rich text.  Any text typed within square brackets during editing is 

shown in colour in the rich text file. 

 

 

 

 

 

 

 

 

 

 

 

Remember: these additional files cannot be used for editing purposes as they are not the required 

format for import. 

 


